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Brief Introduction 

The BY_Connect enables communication by serial ports and Ethernet ports. 

It provides real-time tagging of positioning data and displays graphical 

representation of observable satellite sky maps, signal-to-noise ratio and etc. It 

also allows configuration of receiver functions and saving of receiver output data 

through command transmission via the console. 
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1 Brief Introduction 

The BY_Connect enables communication by serial ports and Ethernet ports. 

It provides real-time tagging of positioning data and displays graphical 

representation of observable satellite sky maps, signal-to-noise ratio and etc. It 

also allows configuration of receiver functions and saving of receiver output data 

through command transmission via the console. 
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2 Home 

The home of BY_Connect is constituted of function list, input window, output 

window and frequently used command list. 

 

Figure 1 Home of BY_Connect 

2.1 Input Window 

One of the main functions of the BY_Connect is to configure the receiver by 

sending commands. After communication is established between the PC and the 

device, the following operations can be performed: 

 "Input box" is used for entering commands. Clicking "Send" 

completes the sending of a command. 

 "Exp path" opens the directory where the software is located. 
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 You can check "Loop (ms)" to repeatedly send commands at the set 

time intervals (in milliseconds). And can click the "Options" button to 

open a dialog that single or looped command can be configured to 

send to multiple ports simultaneously. 

 "Command List" stores commonly used commands for easy sending. 

2.2 Output Window 

There's a dropdown menu of "Select CONN" above the output window, it 

enables you to choose any established port to display its output content. 

Command execution results will also appear in the output window. Incorrect 

command inputs will result in execution failure and an error prompt. The 

following options are included: 

 You can check "Stop" to stop content printing in the output window (does 

not affect data output of device). 

 You can check "Hex Show" to display the output in hexadecimal format. 

 You can check "Only ASC" to hide binary format data, showing data only 

in ASCII format. 

 You can click "Clear" to empty the printed content in the output window. 

2.3 Frequently Used Command 

The "Expand" button can be clicked to reveal the list of commands you 

stored before. This list stores frequently used commands for convenient using. 

The button name will change to "Collapse", and clicking it will hide the list. 
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2.4 Function List 

The symbols in the function list correspond to the following functions: 

 Conn Setting  RTCM Configuration 

 CNR  SKY Map 

 Plot Control  IMU Configuration 

 Log Information   Board Configuration  

 Inertial Navigation Configuration  Lever Compute 

 E-code List  Authorization 

 Firmware Update  Tools 

 Help  
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3 Function List 

3.1 Conn 

This menu contains two functions: "Set" and "RTCM". "Set" is used to 

configure Ethernet and serial port connection, while "RTCM" is used to configure 

differential signal transmission. 

3.1.1 Conn Set 

In the "Set" interface, the following three functions can be configured: 

1. Serial Port Communication 

When the IP and port of the hardware device are unknown, serial 

communication can be established. The specific method is as follows: You can 

click the symbol  in the upper-left list, and then click the "Add Row" button. 

In the newly added row, the "Uart" in the Type column should be selected and 

then choose the serial port number in the Input_1 dropdown, select the baud 

rate in the Input_2 dropdown, at last the "Open" button can be clicked to 

establish serial communication. 

2. Ethernet Port Communication 

If the IP and port of the hardware device are known, Ethernet communication 

can be selected. The specific steps are as follows: You can click the symbol  

in the upper-left list, and then click the "Add Row" button. In the newly added 

row, the "TCP Client" in the Type column should be selected, and then enter the 
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IP address in the Input_1 dropdown, enter the port number in the Input_2 

dropdown, at last the "Open" button can be clicked to establish Ethernet 

communication. 

3. Data Saving 

First, you can click the symbol  in the "File Path" field to choose the file 

saving path. Then click "Open" for the port where you want to save data and 

enter the file name. At last， the "To Save" can be checked to start recording data, 

and uncheck it to stop recording. 

 

Figure 2 Conn Setting Interface 

3.1.2 RTCM Configuration 
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Figure 3 RTCM Configuration Interface 

The BY_Connect supports the access of external differential signals. In the 

RTCM Configuration interface, on the left side, you can configure the IP and port 

number of the signal input source, and on the right side, you can configure the 

IP and port number of the output end (PC's local IP). It also allows you to save 

input and output information. After setting the file path, you can click the "Start" 

button to initiate the RTCM data transmission. 

3.2 View  

There are five modules available in "View": CNR (Carrier-to-Noise Ratio 

Chart), Sky (Sky Chart), Plot (Trajectory Chart), IMU (Inertial Measurement Unit) 

and Log (Log Information). You can click them to use the function. 

3.2.1 CNR 



 

TEL: +86-731-85058117                  www.bynav.com 8 

 

BY_Connect Datasheet 

 

Figure 4 Carrier-to-Noise Ratio Interface 

As the figure shows above, different colors represent different frequency, 

and there will be explanations above the subsystem displays indicating the 

frequency represented by each color. The x-axis represents the satellite identifier, 

while the y-axis represents the carrier-to-noise ratio value. 

On the interface, you can modify the receiving antenna positions as follows: 

Rover Master (main antenna on the rover station), Rover Slave (secondary 

antenna on the rover station) and Base (base station). 

3.2.2 Sky Map 

 

Figure 5 Sky Map Interface 

The color correspondence to constellation in the sky map: red indicates 

BeiDou, green indicates GPS, blue indicates GLONASS and purple indicates 

Galileo. Repeatedly clicking the "Lat/Lon/Height" button toggles the display 
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between three coordinate representations: LLA (in degrees), LLA (in degrees, 

minutes, seconds format) and ECEF coordinates. "Solution" indicates the current 

positioning status, "Age" indicates differential age and "Sat" represents the total 

number of tracking satellites. 

3.2.3 Plot 

 

Figure 6 Plot Interface 

The BY_Connect offers a graphical interface for users to conveniently view 

receiver’s positioning data. After enabling serial/Ethernet communication, you 

can open the Plot interface  and it should display real-

time positioning points. If not, the connection status (like ) and positioning 

output in the console should be ensured. The functions on the top list are: 

connect/disconnect, display content selection (draw trajectory, positioning, 

speed, acceleration, satellites), positioning status filtering, align to origin, scale, 

vertical alignment (adaptive height), show tracking points and real-time 

centering. The bottom status list shows time (GPST), latitude and longitude. 

3.2.4 IMU 
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Figure 7 IMU Analysis Interface 

BY_Connect supports real-time display of inertial navigation system status 

information. In the "View" tab, you can click the "IMU" option to open the IMU 

analysis interface. The upper part of the interface displays gyroscope 

information, while the lower part displays accelerometer information. 

3.2.5 Log 

 

Figure 8 Log Interface 
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In the "View" tab, you can click the "Log" option to display log information 

in the pop-up window and view the output records. 

3.3 Configuration 

The "Configuration" tab allows for quick setup of inertial navigation, 

including the functional modules: Board Config, Inertial Navigation and 

ByOffset. Below is the explanation of these three functions. 

3.3.1 Board Config 

After enabling serial/Ethernet communication, you can click the "Board 

Config" option to display some configuration information about the receiver. 

3.3.1.1 Status Tab 

 

Figure 9 Status Tab 

In the "Status" tab, you can click "Read Status" to retrieve the board's 

configuration. The corresponding parameters from top to bottom are: GPS time, 

board type, version, batch number, program run time, ARM temperature, 
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expiration date, GPS week, CPU usage, antenna 1 supply voltage, antenna 2 

supply voltage, antenna 1 tracked satellites count, antenna 2 tracked satellites 

count, current operating constellation, current operating frequency, operating 

mode, RTK solution status, heading solution status, INS solution status, 

observation frequency, solution frequency, FPGA solution frequency, IMU data 

frequency, base station operating frequency, GLONASS calibration status, 

differential age, base station tracked satellites count, latitude and longitude, 

elevation, base station distance, differential station count, baseline length. You 

can click "Stop" to halt reading. 

3.3.1.2 Board Config Tab 

In the "Board Config" tab, you can read and write configuration files by 

selecting a configuration file. 

 

Figure 10 Board Config Tab 

3.3.1.3 Network Set Tab 

In the "Network Set" tab, you can configure the receiver's interface name, IP 

mode, IP address, subnet mask and gateway parameters. 
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Figure 11 Network Set Tab 

3.3.1.4 NAV Tab 

 

Figure 12 BYNAV Tab 

In the "NAV" tab, you can configure the observation frequency and solution 

frequency, as well as set up communication protocols. 

3.3.2 Inertial Navigation 

The BY_Connect supports to set up the lever arm angles and other general 



 

TEL: +86-731-85058117                  www.bynav.com 14 

 

BY_Connect Datasheet 

configuration of inertial navigation. The inertial navigation configuration 

interface will be opened by clicking on the "INS" option in the "Config" tab. In the 

"Lever Arm" tab, you can configure the position parameters for Lever Arm 1, 

Lever Arm 2 and User Lever Arm. In the "DMI Arm" tab, you can configure the 

NHC lever arm, and after entering the NHC lever arm along with vehicle 

wheelbase and track width, the DMI lever arm can be automatically calculated. 

In the "General Set" tab, you can configure the inertial navigation mode. 

3.3.3 ByOffset 

"ByOffset" is used to calculate the lever arm values in the vehicle coordinate 

system. 

 

Figure 13 ByOffset Interface 
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3.3.3.1 Antenna Installing Position 

With the vehicle coordinate system's Y-axis positive direction parallel          

to the forward direction of the vehicle, there are two antenna installation 

methods: front-back installation and left-right installation. Front-back 

installation further divides into: ANT1 being installed on the front or back side of 

the vehicle. Left-right installation further divides into: ANT1 being installed on 

the left or right side of the vehicle. As shown in Figure 14 , from left to right, the 

options are: ANT1 at the back, ANT1 at the front, ANT1 at the left and ANT1 at the 

right. 

Depending on the antenna installation method, you should select the 

corresponding option in the software interface, as shown in Figure 15. 

If the two antennas are installed diagonally, you can adjust the parameter 

"ANT1->ANT2 (Vehicle frame)" to rotate the vehicle's orientation to the 

horizontal angle where ANT1 points to ANT2's vector, counterclockwise rotation 

is considered positive. For example, if the vector from ANT1 to ANT2 points to the 

right front of the vehicle at a 45° angle, the parameter should be set to -45. 
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Figure 14 Antenna Installation Method 

 

Figure 15 Antenna Installing Position Option 

3.3.3.2 Receiver Installation Method 

There are 24 installation methods for the receiver, determined by selecting 

the installation orientation of the receiver's X-axis and Y-axis. Based on the 

receiver installation method, you can select the corresponding option in the 

software interface, as shown in Figure 16 . 

 

Figure 16 Receiver Installing Position Option 

3.3.3.3 Dual-antenna Position Measurement 

In the condition of keeping the vehicle stationary, you can use the ENUAVR 

command (e.g., LOG COM1 ENUAVR ONTIME 1) to simultaneously obtain the 
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mean position in the ENU frame of reference for both antennas relative to the 

same reference point. 

ENUAVR Example 

#ENUAVR,COM1,0,0.0,FINESTEERING,2095,127522.000,00000000,0000,25;-

1075.1430,-98.4608,-8.6259,-1075.1430,-98.4610,-8.6258,-3.1407,-

0.0016,58*2865555d 

ENUAVR Note 

It is recommended to record the ENUAVR information after 60s of output. 

3.3.3.4 Lever Arm Values Calculation 

After completing the above steps, you can fill in the recorded antenna 

positions in their corresponding positions on the software interface, then click 

the "Calculate" button to obtain the lever arm values and RBV for the dual 

antennas in the vehicle coordinate system. The software will also generate 

configuration command. 

3.3.3.5 Data Verification 

After clicking the "Calculate" button, if a warning "If the combined navigation 

system is not installed on the front side of the carrier, the two antennas position 

may be reversed. Please check!" pops up, you should verify whether the 

combined navigation system is installed on the front side of the antenna in the 

vehicle coordinate system. If the combined navigation system is on the rear side 
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of the antennas, it suggests that the entered dual antenna positions might be 

reversed. In such cases, the schematic on the right will estimate the relative 

position between the combined navigation system and the vehicle based on the 

calculation result. If a warning "Antenna position error!" appears, it indicates 

abnormal dual antenna positions, and you should check for measurement or 

input errors. 

3.3.3.6 Vehicle Attitude Accurate Measurement (Optional) 

While using the above method, the chosen installation method for the 

combined navigation system might have some deviation to the actual situation. 

This deviation can be corrected through RBV calibration. However, this method 

requires both antennas to be installed at the same height on the vehicle and the 

vehicle to be stationary on level ground. The software takes these as conditions 

to determine the vehicle's attitude. 

If the chosen installation method for the combined navigation system closely 

matches the actual situation (deviation less than 1°), you can input the Roll and 

Pitch angles of the combined navigation system in the ENU frame to the software 

by using the ENUAVR information, for achieving a more accurate measurement 

of the vehicle's attitude. This method is more demanding in terms of the 

installation requirements of the combined navigation system but does not 

require both antennas to be at the same height on the vehicle or the vehicle to 

be stationary on level ground. 
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3.3.3.7 Error Control (Optional) 

If the GNSS RTK positioning results have relatively large elevation errors, 

laser distance measuring calibration can be employed. This involves using a 

laser ranger finder with an incline sensor (e.g., BOSCH GLM 500 professional 

laser ranger finder, which can directly measure horizontal and vertical distances) 

to measure the heights of antennas from the same starting plane (e.g., the 

ground) and accurately replace the elevations in the ENU frame. This method can 

significantly reduce Z-axis lever arm errors. 

3.3.3.8 Total Station Measurement (Optional) 

Similar to the previous methods that used RTK positioning results in the ENU 

frame, you can utilize a total station to determine the coordinate of antennas’ 

phase centers and the origin of the combined navigation system in the total 

station's coordinate system (or another coordinate system with a stationary 

origin and axes relative to the ground). You can enter these coordinates into the 

software for ANT1, ANT2 and the auxiliary antenna and set the position of the 

auxiliary antenna in the body frame of the combined navigation system to 0, and 

then the lever arm values of the dual antennas in the vehicle coordinate system 

will be calculated. 

3.4 Tool 

BY_Connect provides several frequently used tools, including Command List, 
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E-code, Authorization, Firmware Upgrade and Tools. 

3.4.1 Command List 

Commands are commonly used to configure receivers. For details of 

commands, please refer to UG017_Interface Protocol. BY_Connect offers a list of 

frequently used commands for receivers. To use this, you can click the "Tool" tab 

and select "Command List" to open a list of commands. You can double-click the 

command to send it to the receiver. 

3.4.2 E-code 

"E-code" displays a list of common fault codes for the receiver. You can 

troubleshoot issues based on the self-diagnostic results. 

3.4.3 Authorization 

You can click "Authorization" in the "Tool" tab to open the authorization 

interface. You can click the "Read" button to read the receiver's unique ID, and 

input the authorization code in the "Authorization" box and click "Send" to 

complete the receiver's authorization. 

3.4.4 Firmware Upgrade 

You can click "Firmware Upgrade" in the "Tool" tab to open the firmware 

update interface as shown in Figure 17 . Please refer to AN049_Firmware 

Update_Bynav for detailed steps and methods of firmware updates. 
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Figure 17 Firmware Update Interface 

3.4.5 Tool 

You can click "Tool" in the "Tool" tab to open the tool interface. You can input 

the statement to be verified in the "CRC" tab, click the "Check Sum" and "32-bit 

CRC" buttons to perform XOR checksum and 32-bit CRC verification. 

3.5 Language 

You can switch the software's display language between Chinese and 

English in the "Language" tab. 

3.6 Help 

You can click "About" in the "Help" tab to display some information about 

the BY_Connect, including contact information of office and support, fax, email, 

company website and address. 
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4 Quick Start Guide 

After opening the BY_Connect, first you should follow the methods in the "Set 

Conn" section to establish communication between the software and hardware. 

The steps to output positioning results: 

 You can enter the command "LOG COM1 BESTPOSA ONTIME 1" in the 

command input interface to configure the positioning results output. 

 You can enter the command "SAVECONFIG" to save the configuration. 

The output result at this point is a single-point solution. 

If the improvement of positioning accuracy to be needed, you should use the 

RTK positioning mode by accessing differential data. COM2 is the default port for 

accessing differential data, the differential data can be received by the network, 

which is then forwarded to the computer port corresponding to COM2. 

If the integrated navigation is used, you should first measure accurate lever 

arm values and approximate RBV values by using ByOffset or precise instruments 

such as total stations. 

 You can input "INSCALIBRATE NEW" to start calibration. 

 You can input "LOG INSCALSTATUSA ONCHANGED" to monitor the 

calibration status. It will be completed when the status displays 

"CALIBRATED", and the estimated RBV will be automatically configured. 

 You can input "SAVECONFIG" to save the configuration. 
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Disclaimer 

This manual provides information about products of Hunan BYNAV Technology Co., Ltd. (hereinafter referred to as 

BYNAV). It does not transfer any rights or licenses of the company or third parties, including but not limited to patents, 

copyrights, trademarks, and proprietary rights in any form. At the same time, BYNAV makes no warranties, express or 

implied, regarding the sale or use of its products, including but not limited to the suitability, marketability or infringement 

liability for intellectual property rights in copyrights, patents, etc. None of them is guaranteed. BYNAV is exempt from 

liability for problems arising from connection or operation that are not required by the manual. BYNAV may modify 

product specifications and descriptions without prior notice if necessary. 

Certain design deficiencies or inadequacies that may exist in products may be improved by version iterations and 

may result in differences between the product and published specifications. The latest product specifications are 

available upon request. 

© Copyright 2013-2023 Hunan BYNAV Technology Co., Ltd. All rights reserved. 
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